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About this manual 
 

Welcome to RQM Interface (RQMI) for IBM Rational® DOORS. 

RQM Interface for IBM Rational DOORS allows you to synchronize data between 
IBM Rational DOORS (DOORS), the world’s leading requirements management 
solution, and Rational Quality Manager (RQM), an integrated enterprise application 
for organizing and managing the entire testing process. You can transfer 
requirements in DOORS to an RQM project, and view the status of tests in RQM 
from within DOORS. 

This document describes how to use the RQM Interface in release 9.2 of DOORS. 
A prerequisite to using the information in this manual is knowledge of both 
DOORS and RQM. 

Typographical conventions 

The following typographical conventions are used in this manual: 

Typeface or 
Symbol 

Meaning 

Bold Important items and items that you can select, including 
buttons and menus. For example: Click Yes to continue. 

Italics Book titles 
Courier Commands, files, and directories; computer output. For 

example: Edit your .properties file. 

> A menu choice. For example: Select File > Open. This 
means select the File menu, then select the Open 
command from it. 
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Installing the RQM Interface 
 

This chapter contains information on how to install and configure RQMI for 
DOORS. 

• Understanding the physical configuration 

• Understanding the installation options 

• System requirements 

• Installation prerequisites 

• Installing the RQM Interface Server 

• Installing an RQM Interface Client 

Understanding the physical configuration 

The RQMI can be configured in two ways depending on the number of remote 
DOORS database servers: 

• All DOORS users work with a single DOORS database server (default) 

• DOORS users can work with multiple DOORS database servers (requires 
additional configuration) 

RQMI configuration 

 

RQMI Server 

The RQMI Server machine is a gateway between the DOORS Client machines and 
the RQM Host machine. 

The DOORS Client software containing the RQMI Server software is installed on 
the RQMI Server machine. The RQMI Server software should be started on system 
startup, and should always be running to enable exports from DOORS Clients and 
synchronization between each DOORS database and RQM. 

DOORS Clients 

The DOORS Client software containing the RQMI Client software is installed on 
each DOORS Client machine. The DOORS Clients are able to log on to multiple 
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DOORS databases. 

Understanding the installation options 

The DOORS installer has two installation options for the RQM Interface. These 
are: 

• RQM Interface Server 

You install an RQM Interface Server on the RQMI Server machine. All DOORS 
Clients will access the RQM system via the RQMI Server machine. Note that the 
DOORS Client software should be installed with the RQM Interface Server 
software. 

• RQM Interface Client 

You install an RQM Interface Client on each DOORS Client that needs to integrate 
with RQM. This allows the DOORS user to access the integration options available 
in the DOORS Client. 

System requirements 

The following sections describe the system requirements for each component of the 
integration: 

• System requirements for the RQM Interface Server 

• System Requirements for the RQM Interface Client 

System requirements for the RQM Interface Server 

The RQM Interface Server is included in the DOORS 9.2 (or later) client installation 
program. 

Before you install the RQM Interface Server you must have: 

• Access to a DOORS database server version 9.2 (or later). The server can be on 
any machine on the network; it does not need to be on the same machine as the 
RQM Interface Server. 

• Access to a RQM server v1.01 or later. The server can be on any machine on the 
network; it does not need to be on the same machine as the RQM Interface 
Server. 

The recommended configuration is to install the RQMI server on a different 
machine to the DOORS database server and the RQM server. The machine on 
which you install the Integration Server must have: 

• Windows 2003 Server SP2 (Enterprise and Standard). 

• A DOORS 9.2 (or later) client with the RQM Interface Server and RQM 
Interface Client options. 
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• Minimum 1 GB RAM. 

System Requirements for the RQM Interface Client 

The RQM Interface Client is included in the DOORS 9.2 (or later) client installation 
program. 

For RQM Interface Client system requirements, refer to the DOORS 9.2 (or later) 
client software system requirements. 

Installation prerequisites 

Create an RQM User Account 

This section assumes a working knowledge of Jazz user administration for RQM. 

The RQMI server uses a predefined RQM user account to synchronize data between 
one or more DOORS databases and RQM. No other people or processes should 
use this predefined user account when logging in to RQM. 

To setup the RQM user account: 
1. Log in to the RQM Jazz server using an account with JazzAdmins 

permissions. 

2. Go to the Jazz User Administration page. 

3. Create a new user account with a User ID of RQMISVR. The user account 
should have JazzUsers repository permissions and a Rational Quality 
Manager – Quality Manager client access license. 

4. Change the password of the RQMISVR user account. You will be asked to 
enter this password during the installation of the RQMI server software. 

5. Go to the Jazz Project Administration page. 

6. Edit each Project Area and add the RQMISVR user as a Member of the 
project. 

Note: Do not restrict the role-based process permissions of the RQMISVR 
user account. 

Note: Whenever a new project is created, you will need to add the 
RQMISVR user a Member of the new project. 

Create a DOORS User Account for each DOORS Database Server 

This section assumes a working knowledge of DOORS user administration. 

The RQMI server uses predefined DOORS user accounts to synchronize data 
between each DOORS database and RQM. No other people or processes should 
use these predefined user accounts when logging in to DOORS. 

To setup the DOORS user accounts: 
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1. Start DOORS and log in to the DOORS database using an account with 
Create Users powers. 

2. Open the Manage Users window. 

3. Create a new user account with a Username of RQMISYNC. The user 
account should have no additional powers, and have at least read access to all 
public projects, modules and views in the database. 

4. Change the password of the RQMISYNC user account. You will need this 
password during the installation of the RQM Interface Server software. 

5. Repeat steps 1 to 4 above for each DOORS database server that will integrate 
with RQM. 

Installing the RQM Interface Server 

The RQMI server is included in the DOORS 9.2 (or later) client installation 
program. Refer to the DOORS Installation Guide for DOORS installation details. 
This section outlines the RQMI server installation steps during the DOORS client 
installation. 

To install the RQMI server: 

1. Install the DOORS client software on the RQMI server machine. During the 
installation the Setup Type screen will be displayed. 

2. On the Setup Type screen select Custom and click the Next button. 

3. On the Custom Setup screen ensure that both DOORS and Rational 
Quality Manager Interface Server are selected. Click the Next button. 

4. On the Rational Quality Manager Interface screen: 

a. Leave the value of the RQMI Server Port Number as7764. This 
should only be changed if you are aware of a potential port conflict. 
DOORS users will need to know the port number when installing 
the RQMI client software. 

b. Enter the name of the RQM server in the RQM Server field. 

c. Enter RQMISVR in the RQM User field. 

d. Enter the password of the RQMISVR user in the RQM Password 
field. 

e. Enter the RQM server port number in the RQM Port field. 
f. Click the Next button. 

5. On the RQMI DOORS User screen: 

a. Enter RQMISYNC in the DOORS User field. 

b. Enter the password of the RQMISYNC user in the DOORS User 
Password field. 

c. Click the Next button. 
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6. Complete the remainder of the installation according to the instructions in the 
DOORS Installation Guide. 

Installing an RQM Interface Client 

The RQMI client is included in the DOORS 9.2 (or later) client installation program. 
Refer to the DOORS Installation Guide for DOORS installation details. This 
section outlines the RQMI client installation steps during the DOORS client 
installation. 

To install an RQMI client: 

1. Install the DOORS client software on the users machine. During the 
installation the Setup Type screen will be displayed 

2. On the Setup Type screen select Custom and click the Next button. 

3. On the Custom Setup screen ensure that both DOORS and Rational 
Quality Manager Interface are selected. Click the Next button. 

4. On the Rational Quality Manager Interface screen: 

a. Enter the port number of the RQMI server in the RQMI Server 
Port Number field. This will be 7764 unless it was changed by the 
RQMI system administrator. 

b. Enter the name of the RQMI server in the RQMI Server field. 

c. Click the Next button. 

5. Complete the remainder of the installation according to the instructions in the 
DOORS Installation Guide. 
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Running the RQMI Server 
 

This chapter contains information on how to run the RQMI server. 

• Running the RQMI Server 

• Managing the automatic synchronizer 

Running the RQMI Server 

The RQMI server is a gateway between each DOORS database and RQM. DOORS 
clients wishing to integrate with RQM will do so via the RQMI server.  

Configure RQMI Server Software for Synchronization 

During the installation process the RQMI server will be configured for 
synchronization with the default DOORS database. If your DOORS 
implementation only consists of one DOORS database server, you can skip this 
subsection. 

If your DOORS implementation consists of multiple DOORS database servers, 
each DOORS database server (except the server entered during installation) will 
need to be registered with the RQMI server for synchronization. You only need to 
do this once after installation of the RQMI server software. 

 

To register the additional DOORS databases with the RQMI server: 
1. Open a Command console window on the RQMI server machine. 

2. Using the DOS cd command, navigate to the folder 
\Program 
Files\IBM\Rational\DOORS\9.2\RQMInterface\Server\IM\bin\ 

Note: The name of the \9.2\ folder in the above path will depend on which 
version of DOORS you have installed. 

3. For each DOORS Database server (except the server entered during 
installation) repeat step 4 below. 

4. Execute the command 
admin –a {DOORS Host} {DOORS Port} {Username} {Password} 

Where: 

{DOORS Host}  = Name of the DOORS Database Server. This is displayed on 
the DOORS login dialog. 

{DOORS Port}  = Port number of the DOORS Database Server. This is 
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displayed on the DOORS login dialog, and is usually 36677. 

{Username} = Username of the DOORS synchronization user account. This 
will be RQMISYNC. 

{Password} = Password of the DOORS synchronization user account. 

 

5. Close the Command console window. 

Starting the RQMI server software 

To start the RQMI server software: 

1. Start RQM (if it has not been started) and wait for the RQM startup process to 
complete. 

2. From the Windows Start menu select All Programs > IBM Rational > IBM 
Rational Tools > IBM Rational DOORS for RQM Interface > RQMI 
Server Start. 

3. A console window is displayed showing a log of the startup process. When the 
server has started, the console will display the following log text 

INFO: Server started with database from build 
v1.01.0001 

Note: The version number will depend on which version of the RQMI 
server is installed. 

Stopping the RQMI server software 

The RQMI server software should be running while RQM is running. If RQM is 
stopped, then the RQMI server software should also be stopped. 

To stop the RQMI server software: 
1. From the Windows Start menu select All Programs > IBM Rational > IBM 

Rational Tools > IBM Rational DOORS for RQM Interface > RQMI 
Server Stop. 

Note: When the RQMI server is stopped, any exports or synchronizations 
that were in progress will be terminated and have a status of 
‘Failed’. 

Managing the automatic synchronizer 

The RQMI Server includes an automatic synchronizer which periodically updates 
RQM with changes to exported requirements in DOORS. The minimum interval 
between synchronizations is 10 minutes. 

The automatic synchronizer is preconfigured to run at intervals of 1440 minutes (i.e. 
24 hours) between synchronization cycles. The time taken to perform a 
synchronization cycle depends on the volume of data being synchronized. 
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The automatic synchronizer can be disabled and re-enabled, and the interval 
between synchronization cycles can be changed. 

Disabling the automatic synchronizer 

To disable automatic synchronization: 

1. Open a Command console window on the RQMI server machine. 

2. Using the DOS cd command, navigate to the folder 
\Program 
Files\IBM\Rational\DOORS\9.2\RQMInterface\Server\IM\bin\ 

Note: The name of the \9.2\ folder in the above path will depend on which 
version of DOORS you have installed. 

3. Execute the command 

admin –s 0 

4. Close the Command console window. 
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Re-enabling the automatic synchronizer 

To enable automatic synchronization: 
1. Open a Command console window on the RQMI server machine. 

2. Using the DOS cd command, navigate to the folder 
\Program 
Files\IBM\Rational\DOORS\9.2\RQMInterface\Server\IM\bin\ 

Note: The name of the \9.2\ folder in the above path will depend on which 
version of DOORS you have installed. 

3. Execute the command 

admin –s 1 

4. Close the Command console window. 

Changing the interval between synchronization cycles 

To change the synchronization interval: 
1. Open a Command console window on the RQMI server machine. 

2. Using the DOS cd command, navigate to the folder 
\Program 
Files\IBM\Rational\DOORS\9.2\RQMInterface\Server\IM\bin\ 

Note: The name of the \9.2\ folder in the above path will depend on which 
version of DOORS you have installed. 

3. Execute the command 

admin –s {minutes} 

Where: 

{minutes}  = Interval between synchronization cycles in minutes. The 
minimum value is 10. 

Note: The recommended interval is 1440 minutes (i.e. 24 hours). 

4. Close the Command console window. 
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Understanding the Integration 
Workflow 

 

This chapter contains a summary of the workflow between DOORS and RQM. It is 
recommended that you read this section before using the RQM Interface. 

• Exporting requirements from DOORS to RQM 

• Requirements driven testing in RQM 

• Synchronizing requirements changes to RQM 

• Running a traceability report of test cases to requirements 

• Running a requirements test report 

Exporting requirements from DOORS to RQM 

The workflow begins with the export of a DOORS view to an RQM test plan. The 
export process is asynchronous, meaning that the DOORS user posts an export 
request to the RQMI server and is then able to continue working with DOORS 
while the RQMI server and RQM service the request. The larger the volume of data 
being exported, the longer it will take the RQMI server and RQM to service the 
request. The DOORS user is able to check the completion status of the export after 
the request has been posted. 

After a successful export, a new requirement is created in the RQM database for 
each object in the DOORS view that contains text in the object text field. Objects 
with no text in the object text field are not exported.  

If a DOORS object has previously been exported, any subsequent changes to its 
object text will result in the corresponding requirement in RQM being updated. 
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The following table describes the fields of an exported requirement in RQM: 

RQM Requirement 
Field 

Description 

Status The Status icon has three possible states: 

 

Updated  : requirement was previously exported to 
RQM and the object text of the source object in 
DOORS was subsequently updated. 

Removed : requirement was previously exported to 
RQM and subsequently deleted in DOORS. 

Normal : (default) requirement is new in RQM or 
was previously exported to RQM and its object text 
has not changed in DOORS. 

ID {RQM unique identifier} 

Tag {Blank} 

Name {DOORS object identifier}: {DOORS 
module name} 

After a requirement has been exported to RQM the 
Name will not change, even if the name of the source 
DOORS module subsequently changes. 

Clicking the Name hyperlinks to the object in 
DOORS. 

Description {DOORS object text} 

OLE objects are represented as ‘>> OLE object’. 

DOORS tables are represented as ‘>> DOORS 
Table’. 

Owner ‘Unassigned’ 
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Requirements driven testing in RQM 

The RQM user opens the test plan in RQM containing the exported requirements, 
and associates test cases to each requirement. Execution records are generated for 
each test case and tests are conducted in the usual way, with the results recorded 
against the execution records. 

Note: In ‘Step 1’ of the RQM ‘Generate Test Execution Records’ screen the 
‘Test Plan’ defaults to ‘Unassigned’. Ensure that the correct test plan is 
selected when creating the test execution records. 

Synchronizing requirements changes to RQM 

After a set of DOORS objects have been exported to RQM, the object text of some 
of the objects may change. The synchronization process ensures that theses changes 
are propagated to RQM. 

The synchronization process is run periodically and its duration increases with the 
volume of data that has been exported to RQM. The interval between each 
synchronization cycle can be configured on the RQMI server. The default interval is 
24 hours. 

Running a traceability report of test cases to requirements 

The DOORS user is able to generate a traceability report of DOORS objects to 
RQM test plans and test cases. The traceability report is based on the unfiltered list 
of objects in the DOORS module.  

Generating the traceability report also creates/updates DOORS external links from 
objects in DOORS to their linked test cases in RQM. 

Caution: The traceability report identifies test plans by the name. When viewing 
the traceability report be aware that RQM does allow duplicate test 
plan names within the same project. 
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The traceability report consists of the following DOORS columns: 

DOORS Column Description 

ID {DOORS object id} 

 {Object heading} 

{Object text} 

Test Plan 
and Test 
Cases 

The following format is repeated for each project and 
the test plans within it: 

 

{RQM project name} 

     {test plan name} 

          {test case id}:{test case name} 

          : 

          {test case id}:{test case name} 
 

 

Running a requirements test report 

The DOORS user is able to generate a test report showing the test coverage and 
statement of quality for exported objects. The list of objects in the test report is 
based on the objects in the exported view. 

The following table describes the column values in the test report for each exported 
object: 

DOORS Column Description 

ID {DOORS object id} 

 {Object heading} 

{Object text} 

Test Cases The linked test cases in the test plan with the rolled up 
verdict in the format: 

 

({test case id}) {test case name}: 
{verdict} 

Test Status The test status provides an indication of test coverage. 
The three possible values are: 
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DOORS Column Description 

 

{blank} : No linked test cases. 

Approved : All linked test cases are approved. 

Not Approved : Not all linked test cases are 
approved. 

Verdict The rolled up statement of quality for the DOORS 
object based on the last run of each test execution record 
for linked test cases. 

Passed 

Deferred 

Incomplete 

Inconclusiv
e 

Error 

Partially 
Blocked 

Blocked 

Failed 

Perm Failed

The status columns show the number of test execution 
records for each linked test case where the verdict of the 
last run matches the status column name. The format is: 

 

{test case id}: {number of execution 
records with matching verdict} of 
{total number of execution records} 
 

e.g.  231: 2 of 6 

Verdict 
Changed 

Identifies whether the Verdict has changed since the last 
run. A ‘Yes’ is not overwritten when the report is re-
run. However, the DOORS user is able to clear the 
value in this column. 
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In the test report, the test status and results are rolled up to parent objects with 
heading text but no object text. The following table describes the column values in 
the test report for each rolled up parent object: 

DOORS Column Description 

ID {DOORS object id} 

 {Object heading} 

Test Cases {blank} 

Test Status Rolled up test coverage. The four possible values are: 

 

{blank} : All child objects have a blank 
status. 

Mixed Status : Child objects have different 
statuses. 

Approved : All child objects have approved 
status. 

Not Approved : All child objects are not 
approved. 

Verdict Rolled up statement of quality. 
Passed 

Deferred 

Incomplete 

Inconclusiv
e 

Error 

Partially 
Blocked 

Blocked 

Failed 

Perm Failed

The status columns show the number of linked test 
cases where the rolled up Verdict matches the status 
column name.  

 

Verdict 
Changed 

Identifies whether the rolled up Verdict has changed 
since the last run. 
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Using the RQM Interface 
 

This chapter contains information for DOORS users on how to use the RQM 
Interface. It is recommended that you read the previous section before reading this 
section. 

• How to export requirements to RQM 

• How to initiate a synchronization 

• How to run a traceability report 

• How to run a test report 

How to export requirements to RQM 

The export process consists of two phases. 

The first phase involves the DOORS user initiating and posting the export request 
to the RQMI server. During this phase a progress bar is displayed while the data for 
export is packaged prior to posting. The DOORS user is able to cancel the export by 
clicking the Cancel button on the progress bar window. 

The second phase starts when the export request has been posted to the RQMI 
server. This phase is asynchronous, meaning that the DOORS user is then able to 
continue working with DOORS while the data is being exported to RQM. This 
phase cannot be cancelled by the DOORS user.  

Larger DOORS modules take longer to process (during both phases) than smaller 
DOORS modules. The DOORS user is able to check the completion status of the 
export after the request has been posted. 

Export a DOORS view to RQM 

To perform an export, the DOORS user filters a DOORS module so that only the 
objects to be exported are listed. The filtered list is saved as a public DOORS view 
and the view is exported to an existing or new RQM test plan. 

After a successful export, a new requirement is created in the RQM database for 
each object in the DOORS view that contains text in the object text field. Objects 
with no text in the object text field are not exported. The exported requirements are 
linked to the RQM test plan specified at the time of export. 

To export a DOORS view to an RQM test plan: 
1. Open a DOORS module. 

2. Use the module filter to only include the objects to be exported to RQM. 

3. Save the filtered module as a public DOORS view (ensure that the Access to 
this view option on the Save as dialog is set to Public). 
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4. From the module menu select RQM > Export to RQM. After a short delay 
the Test Plan dialog is displayed. 

5. The first pick-list on the dialog contains a list of projects in RQM. The pick-list 
defaults to the first project in the list. If the target project for export is not 
selected, select it from the pick-list. 

6. You are able to export the objects in the view to an existing RQM test plan or 
a new RQM test plan. 

a. To export to an existing RQM test plan, select the test plan from 
the pick-list below the Select a test plan from the list option. 

b. To export to a new RQM test plan, click the To create a new test 
plan, enter the name of the new test plan option and enter the 
test plan name in the enabled text box. 

7. Click the Export button. A progress bar will be displayed while the data is 
packaged for export. 

8. After the export request has been posted to the RQMI server, a confirmation 
message is displayed. Read the message and then click OK. 

9. The exported data will now be processed by the RQMI server, and then sent to 
RQM for import to the test plan. To check the status of the export, from the 
module menu select RQM > View Export Status. 

10. When the export process has completed successfully, the RQM > View 
Export Status option will display a dialog showing the export status as 
‘Completed’. The dialog has a Go to URL button which opens the target test 
plan in RQM. The dialog also has a Copy URL button which copies the RQM 
test plan URL to the windows clipboard. 
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Clear the association between a DOORS view and an RQM test plan 

A DOORS view is permanently associated to the RQM test plan to which the view 
was exported. A DOORS view can only be associated with one RQM test plan. If 
you decide that the view should no longer be associated to the test plan, you can 
clear the test plan association. Clearing the test plan association removes the 
exported requirements from the RQM test plan, and allows the view to be exported 
to another test plan. 

To clear the views test plan association: 

1. In a DOORS module select an exported view. 

2. From the module menu select RQM > Clear Test Plan Association. 

3. Read the message and click Yes to proceed. 

4. The test plan association will be cleared and a confirmation message is 
displayed. Click OK on the confirmation message.  

5. If a traceability report was generated prior to clearing the test plan, then the 
traceability attributes and external links can be cleared by running the 
traceability 

Note: If a traceability report was run prior to clearing the test plan, then the 
traceability attributes and external links can be cleared by rerunning the 
traceability report. 

How to initiate a synchronization 

After a DOORS view has been exported to RQM, changes to the exported DOORS 
objects are propagated to RQM periodically by the automatic synchronizer. The 
period between synchronization cycles defaults to 24 hours, but can be configured 
by the RQMI system administrator. The DOORS user is able to force an immediate 
synchronization request by re-exporting the DOORS view. 

To re-export a DOORS view containing changes: 

1. In a changed DOORS module select an exported view. 

2. From the module menu select RQM > Export to RQM. After a short delay 
the Test Plan dialog is displayed with the options disabled and the test plan 
name selected. 

3. Click the Export button. A progress bar will be displayed while the data is 
packaged for export. 

4. After the export request has been posted to the RQMI server, a confirmation 
message is displayed. Read the message and then click OK. 

5. The exported data will now be processed by the RQMI server, and then sent to 
RQM for update. To check the status of the export, from the module menu 
select RQM > View Export Status. 

6. When the export process has completed successfully, the RQM > View 
Export Status option will display a dialog showing the export status as 
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‘Completed’. The dialog has a Go to URL button which opens the target test 
plan in RQM. The dialog also has a Copy URL button which copies the RQM 
test plan URL to the windows clipboard. 

How to run a traceability report 

The traceability report is based on the unfiltered list of objects in the DOORS 
module, and shows the linked RQM test plans and test cases. Running the 
traceability report also creates/updates DOORS external links from objects in 
DOORS to their linked test cases in RQM. 

To run a traceability report: 
1. Open a DOORS module containing one or more views that have been 

exported to RQM. 

2. From the module menu select RQM > Run Traceability Report. A progress 
bar is displayed while the report is being run. 

3. When the report has been generated a confirmation message is displayed. Click 
the OK button. 

4. If required, you can save the report as a DOORS view. 

How to run a test report 

The test report is based on the filtered list of objects in an exported DOORS view. 
The report shows the test coverage and statement of quality of exported objects. 

To run a test report: 
1. In a DOORS module select an exported view. 

2. From the module menu select RQM > Run Test Report. A progress bar is 
displayed while the report is being run. 

3. When the report has been generated a confirmation message is displayed. Click 
the OK button. 

4. If required, you can save the report as a DOORS view. 

5. The Verdict Changed column contains ‘Yes’ for any objects where the 
verdict changed since the last time the report was run. 

a. To clear the Verdict Changed for individual objects, in the 
test report delete the value from the Verdict Changed field of 
each object. 

b. To clear the Verdict Changed for all objects in the report, 
select the exported view and then from the module menu select 
RQM > Clear All Verdict Changed. 
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System Administration 
 

This chapter contains information for the RQMI System Administrator. 

• Changing the RQM server properties 

• Changing the RQM user credentials 

• Changing the DOORS database server properties and user credentials 

• Changing the RQMI server name and port number 

• Backing up and restoring the RQMI server database 

• Changing the logging level 

Changing the RQM server properties 

Occasion may arise when you need to change the RQM server name or port 
number. For example, a port conflict may require a port number change, or the 
RQM database may be moved to a new machine. 

To change the RQM server name and port number: 

1. Stop the RQMI server. 

2. On the RQMI server machine use Windows Notepad to open the file 
server.properties in the folder 
\Program Files\IBM\Rational\DOORS\9.2\RQMInterface\Server\IM\conf\ 

Note: The name of the \9.2\ folder in the above path will depend on which 
version of DOORS you have installed. 

3. Change the value of the rqm.server.hostname property to the new 
RQM server name. 

4. Change the value of the rqm.server.portno property to the new RQM 
server name. 

5. Save the file and close Windows Notepad. 

6. Restart the RQMI server. 

Changing the RQM user credentials 

If the password of the RQMISVR user account on RQM changes, the configuration 
on the RQM server must be updated. The configuration should also be updated if 
there is a need to use a different user account. 

To change the RQM user name: 
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1. Stop the RQMI server. 

2. On the RQMI server machine use Windows Notepad to open the file 
server.properties in the folder 
\Program Files\IBM\Rational\DOORS\9.2\RQMInterface\Server\IM\conf\ 

Note: The name of the \9.2\ folder in the above path will depend on which 
version of DOORS you have installed. 

3. Change the value of the rqm.login.j_username property to the new 
RQM user name. 

4. Save the file and close Windows Notepad. 

5. Restart the RQMI server. 

To change the RQM password: 

1. Stop the RQMI server. 

2. Open a Command console window on the RQMI server machine. 

3. Using the DOS cd command, navigate to the folder 
\Program 
Files\IBM\Rational\DOORS\9.2\RQMInterface\Server\IM\bin\ 

Note: The name of the \9.2\ folder in the above path will depend on which 
version of DOORS you have installed. 

4. Execute the command 

admin –p {Password} 

Where: 

{Password}  = The password of the RQM user account. 

5. Restart the RQMI server. 
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Changing the DOORS database server properties and user 
credentials 

Occasion may arise when you need to change the DOORS database server name, 
port number, user name or password. For example, a port conflict may require a 
port number change, the DOORS database may be moved to a new machine, or the 
DOORS password may change. 

To change the DOORS database server properties or DOORS user 
credentials: 
1. Stop the RQMI server. 

2. Open a Command console window on the RQMI server machine. 

3. Using the DOS cd command, navigate to the folder 
\Program 
Files\IBM\Rational\DOORS\9.2\RQMInterface\Server\IM\bin\ 

Note: The name of the \9.2\ folder in the above path will depend on which 
version of DOORS you have installed. 

4. Execute the command 
admin –m {Old DOORS Host} {Old DOORS Port} {New DOORS 
Host} {New DOORS Port} {New Username} {New Password} 

Where: 

{Old DOORS Host}  = The previous DOORS Database server name. 

{Old DOORS Port}  = The previous DOORS Database port number. 

{New DOORS Host}  = The new DOORS Database server name. This is 
displayed on the DOORS login dialog. 

{New DOORS Port}  = The new DOORS Database port number. This is 
displayed on the DOORS login dialog. 

{New Username}  = Username of the DOORS synchronization user 
account. If this hasn’t changed it will be RQMISYNC. 

{New Password}  = Password of the DOORS synchronization user 
account. 

5. Restart the RQMI server. 

Changing the RQMI server name and port number 

Occasion may arise when you need to change the configured RQMI server name or 
port number. For example, a port conflict may require a port number change, or you 
may need to use an IP address for the RQMI server name. 

To change the RQMI server name and port number: 
1. Stop the RQMI server and close DOORS on each client machine. 
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2. On each client machine use Windows Notepad to open the file 
client.properties in the folder 
\Program Files\IBM\Rational\DOORS\9.2\RQMInterface\Client\IM\conf\ 

Note: The name of the \9.2\ folder in the above path will depend on which 
version of DOORS you have installed. 

3. Change the value of the rqmi.server.host property to the new RQMI 
server name or IP address. The value must be in lowercase. 

4. Change the value of the rqmi.server.port property to the new RQMI 
port number. This should be an unblocked and free port on the RQMI server. 

Note: The port number must be between 1024 and 65535. 
5. Save the file and close Windows Notepad. 

6. On the RQMI server machine use Windows Notepad to open the file 
server.properties in the folder 
\Program Files\IBM\Rational\DOORS\9.2\RQMInterface\Server\IM\conf\ 

Note: The name of the \9.2\ folder in the above path will depend on which 
version of DOORS you have installed. 

7. If the rqmi.this.host property is missing then add the property. Set the 
value of the property to the same value entered for the 
rqmi.server.host property in the client.properties file on the 
clients (step 3 above). The value must be in lowercase. 

Note: You should only add or change the rqmi.this.host property if 
you have specified an IP address or a fully qualified machine name in 
step 3 above. 
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8. Change the value of the rqmi.server.port property to the new RQMI 
port number (see step 4 above). 

9. If the rqmi.server.port2 property is missing then add the property. Set 
the property to a new port number that is unblocked and available on the 
RQMI server. If the property is not specified, it will default to 7765. 

Note: The port numbers must be between 1024 and 65535. 
10. Save the file and close Windows Notepad. 

 

Backing up and restoring the RQMI server database 

The RQMI server uses an Apache Derby database to store the Ids and timestamps 
of the DOORS objects exported to RQM. The data in the RQMI server database 
mirrors the data exported to RQM. Hence, the RQMI server database should be 
backed up whenever the RQM database is backed up, and the RQMI server database 
should be restored whenever the RQM database is restored. 

The RQMI server database is located in the folder 
\Program Files\IBM\Rational\DOORS\9.2\RQMInterface\Server\rqmdrsDB 

Note: The name of the \9.2\ folder in the above path will depend on which 
version of DOORS you have installed. 

 

IMPORTANT: 

• Backup the RQMI server database whenever the RQM database is backed up. 

• Restore the RQMI server database whenever the RQM database is restored. 

• Consider using a consistent file naming convention for RQM and RQMI server 
backup files, so that the two files can easily be associated. 

• Consider automating the backup process for RQM and the RQMI server. 

 

To backup the RQMI server database to a backup file: 
1. Open a Command console window on the RQMI server machine. 

2. Using the DOS cd command, navigate to the folder 
\Program 
Files\IBM\Rational\DOORS\9.2\RQMInterface\Server\IM\bin\ 

Note: The name of the \9.2\ folder in the above path will depend on which 
version of DOORS you have installed. 

3. Execute the command 
admin –e “{backup filename}” 

e.g. admin –e “c:\backups\rqmi\rqmi_2jan09.zip” 
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Where: 

{backup filename}  = The full path and filename of the target backup 
file. The filename extension should be .zip. 

 

To restore the RQMI server database from a backup file: 
1. Stop the RQMI server. 

2. Open a Command console window on the RQMI server machine. 

3. Using the DOS cd command, navigate to the folder 
\Program 
Files\IBM\Rational\DOORS\9.2\RQMInterface\Server\IM\bin\ 

Note: The name of the \9.2\ folder in the above path will depend on which 
version of DOORS you have installed. 

4. Execute the command 
admin –i “{backup filename}” 

e.g. admin –i “c:\backups\rqmi\rqmi_2jan09.zip” 

Where: 

{backup filename}  = The full path and filename of the backup file. 

5. When the restore has completed, the previous database folder will have been 
renamed to rqmdrsDB-yymmddhhnnss, e.g. rqmdrsDB-090214132648. 

6. Restart the RQMI server. 

Changing the logging level 

The RQMI server outputs execution information to log files in the folder 
\Program Files\IBM\Rational\DOORS\9.2\RQMInterface\Server\IM\logs 

There are two logging levels. 

Logging level 1 logs errors and minimal execution information. This is the default 
logging level and should not be changed unless asked to so by IBM Support. 

Logging level 2 logs errors and full execution information. At this logging level the 
size of the log files increases very quickly. IBM Support may ask for logging to be set 
to level 2 to help with the diagnosis of a support incident. After the logs have been 
copied and sent to IBM, the log files should be deleted and the logging level set back 
to 1. 

 
To change the logging level: 

1. Stop the RQMI server. 

2. On the RQMI server machine use Windows Notepad to open the file 
server.properties in the folder 
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\Program Files\IBM\Rational\DOORS\9.2\RQMInterface\Server\IM\conf\ 

Note: The name of the \9.2\ folder in the above path will depend on which 
version of DOORS you have installed. 

3. Change the value of the integration.logging.level property to the 
required logging level (i.e. 1 or 2). 

4. Save the file and close Windows Notepad. 

5. Restart the RQMI server. 
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Contacting Support 
 

Contacting IBM Rational Software Support  

Support and information for Telelogic products is currently being transitioned from 
the Telelogic Support site to the IBM Rational Software Support site. During this 
transition phase, your product support location depends on your customer history.  

Product support  

• If you are a heritage customer, meaning you were a Telelogic customer prior 
to November 1, 2008, please visit the System Architect Support Web site.  
 
Telelogic customers will be redirected automatically to the IBM Rational 
Software Support site after the product information has been migrated.  

• If you are a new Rational customer, meaning you did not have Telelogic-
licensed products prior to November 1, 2008, please visit the IBM Rational 
Software Support site.  

Before you contact Support, gather the background information that you will need 
to describe your problem. When describing a problem to an IBM software support 
specialist, be as specific as possible and include all relevant background information 
so that the specialist can help you solve the problem efficiently. To save time, know 
the answers to these questions:  

• What software versions were you running when the problem occurred?  

• Do you have logs, traces, or messages that are related to the problem?  

• Can you reproduce the problem? If so, what steps do you take to reproduce 
it?  

• Is there a workaround for the problem? If so, be prepared to describe the 
workaround.  

Other information  

For Rational software product news, events, and other information, visit the IBM 
Rational Software Web site.  
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Appendix: Notices 
© Copyright IBM Corporation 2009, 2010  

US Government Users Restricted Rights—Use, duplication or disclosure restricted 
by GSA ADP Schedule Contract with IBM Corp. 

This information was developed for products and services offered in the U.S.A. 
IBM may not offer the products, services, or features discussed in this document in 
other countries. Consult your local IBM representative for information on the 
products and services currently available in your area. Any reference to an IBM 
product, program, or service is not intended to state or imply that only that IBM 
product, program, or service may be used. Any functionally equivalent product, 
program, or service that does not infringe any IBM intellectual property right may be 
used instead. However, it is the user's responsibility to evaluate and verify the 
operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not grant you any 
license to these patents. You can send written license inquiries to: 

IBM Director of Licensing  
IBM Corporation  
North Castle Drive  
Armonk, NY 10504-1785 

For license inquiries regarding double-byte character set (DBCS) information, 
contact the IBM Intellectual Property Department in your country or send written 
inquiries to: 

Intellectual Property Licensing 
Legal and Intellectual Property Law 
IBM Japan Ltd. 
1623-14, Shimotsuruma, Yamato-sh 
Kanagawa 242-8502 Japan  

The following paragraph does not apply to the United Kingdom or any other 
country where such provisions are inconsistent with local law: 
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES 
THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some 
states do not allow disclaimer of express or implied warranties in certain 
transactions. Therefore, this statement may not apply to you. 

This information could include technical inaccuracies or typographical errors. 
Changes are periodically made to the information herein; these changes will be 
incorporated in new editions of the publication. IBM may make improvements 
and/or changes in the product(s) and/or the program(s) described in this 
publication at any time without notice. 
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Any references in this information to non-IBM Web sites are provided for 
convenience only and do not in any manner serve as an endorsement of those Web 
sites. The materials at those Web sites are not part of the materials for this IBM 
product and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes 
appropriate without incurring any obligation to you.  

Licensees of this program who wish to have information about it for the purpose of 
enabling: (i) the exchange of information between independently created programs 
and other programs (including this one) and (ii) the mutual use of the information 
which has been exchanged, should contact: 

Intellectual Property Dept. for Rational Software  
IBM Corporation 1 Rogers Street Cambridge,  
Massachusetts 02142 
U.S.A 

Such information may be available, subject to appropriate terms and conditions, 
including in some cases, payment of a fee.  

The licensed program described in this document and all licensed material available 
for it are provided by IBM under terms of the IBM Customer Agreement, IBM 
International Program License Agreement or any equivalent agreement between us. 

Any performance data contained herein was determined in a controlled 
environment. Therefore, the results obtained in other operating environments may 
vary significantly. Some measurements may have been made on development-level 
systems and there is no guarantee that these measurements will be the same on 
generally available systems. Furthermore, some measurements may have been 
estimated through extrapolation. Actual results may vary. Users of this document 
should verify the applicable data for their specific environment. 

Information concerning non-IBM products was obtained from the suppliers of 
those products, their published announcements or other publicly available sources. 
IBM has not tested those products and cannot confirm the accuracy of 
performance, compatibility or any other claims related to non-IBM products. 
Questions on the capabilities of non-IBM products should be addressed to the 
suppliers of those products. 

This information contains examples of data and reports used in daily business 
operations. To illustrate them as completely as possible, the examples include the 
names of individuals, companies, brands, and products. All of these names are 
fictitious and any similarity to the names and addresses used by an actual business 
enterprise is entirely coincidental. 

If you are viewing this information softcopy, the photographs and color illustrations 
may not appear. 

Trademarks 

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of 
International Business Machines Corp., registered in many jurisdictions worldwide. 
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Other product and service names might be trademarks of IBM or other companies. 
A current list of IBM trademarks is available on the Web at  
www.ibm.com/legal/copytrade.html. 

Microsoft and Windows are trademarks of Microsoft Corporation in the United 
States, other countries, or both. 

Other company, product or service names mentioned may be trademarks or service 
marks of others. 

 

 

 

 
 
 




